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Shareware
This product is Shareware. Shareware is a form of software distribution, not free software. If you 
have not already registered this product, you have the right to evaluate it for a period of 30 days from
the date you initially install it. If you find that it suits your needs and you wish to continue to use it 
after the 30 day period you are required to register it with Oakley Data Services, or with an agent in 
your territory. There are significant advantages to registering your copy, not least the continued 
availability of good quality software at reasonable prices.

You also have the right, and in fact you are actively encouraged, to distribute copies of the 
Shareware version of this product. It must, however remain in its original, unmodified state, and all its
constituent files must be included. No-one may charge for the program itself, although a reasonable 
fee for the media used and copying costs is allowable.

You may not distribute copies of the registered version of this product.
This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchant ability, or 
fitness for a particular purpose.

In no event will the Author or any of his agents, or assigns, or any organisation distributing Smart 
Address, on its behalf be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use of, or inability to use the program.

All trademarks are acknowledged.
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What is Smart Address ?
Smart Address has been designed as an easy to use and convenient Telephone and Address Book 
for your Windows Desktop, by having Smart Address always running you will have your Address 
book only a mouse click away. 

Smart Address presents each Address Book in it's own Window. Entries are displayed, by name, in a 
scrolling list on the left hand side of the Address Book. Selecting a name from this list will result in the
complete entry being displayed on the right hand side. 

Not only does Smart Address store all your telephone numbers and addresses, but it also allows you 
to:-
n Have notes kept with each entry
n Group Entries into any number of categories you care to define
n Have more than one Address Book open at the same time
n Import and Export Entries to and from text files
n Display Entries using powerful Search and Index facilities
n Copy Entries to and from the Windows Clipboard
n Inserts Entries directly into your Word Processor
n Undo the last amendment to an Address Book
n Automatically dial a number from an Address Book
n Print Single of Multiple Envelopes
n Print Single or Multiple Mailing Labels



Restricting the Entries Displayed
By default, Smart Address displays all entries in the Address Book in a scrollable list on the left side 
of the Address Book Window. This list can be filtered by use of the Index Command. This will display 
a dialogue box, allowing the display index to be specified. The dialogue box consists of two 
sections:

Index Character
The Index Character restricts the display to only those entries that begin with the character selected. 
To select all entries use the ALL button.

Index Category
The Index Category restricts the display to only those entries that have been grouped within the 
selected category. To select all categories, select <All Categories>.
Both of these fields compliment each other. That is to say if you have an Index Character of "A" and 
an Index Category of "Personal", only the entries beginning with "A" that are in the category 
"Personal" will be displayed.



Searching the Address Book
By using the Find Command a Search may be performed against the current Address Book. The 
Search is controlled by the following options:-

Text to Find
This field is used to specify the string that is to be search for. Searches are case insensitive.

Origin
This has two options, the first instructs Smart Address to search every entry in the Address Book for 
the string specified.

The other causes the search to only be performed against the entries currently displayed. This allows
for a search to be performed on a sub-set of Address Book entries, created by use of the Index 
Command or a previous search.

Method
This has two options, the first instructs Smart Address that the search is to be a Wild search. A Wild 
search means that the string can appear anywhere within the field being checked, for example a wild
search for ER would list entries such as ERIC, PETER, etc. 

The other option is for a Specific search, which means that the field being checked can only contain 
the string specified and no other characters.

Fields
This has two options, the first instructs Smart Address to search every field of an entry for the string 
specified. The other allows individual fields to be selected for inclusion in the search. 

Selecting the second option, causes the dialogue box to be extended to allow for individual fields to 
be chosen.



Changing an Address Books Field Labels
Each Address Book entry consists of 11 fields. By default each field is named according to the field 
names defined by Smart Address. The Set Field Labels Command allows the you to change the 
labels within the currently selected Address Book. 

Each set of labels are held within it's own Address Book, allowing different Address Books to have 
different labels.
 
When the labels have been changed as required, the Dialogues OK button should be pressed and 
the labels will then be applied to the Address Book.



Printer Setup
Before Smart Address can print any envelopes or labels, the printer settings to be used have to be 
defined. 

When Smart Address prints an envelope or label, it will print the contents of the first six Address 
Book fields. In addition you can define a return address 
and a logo, that will be printed as well.
 
To set the various options, the Printer Setup Command displays a dialogue box that allows these 
settings and choices to be defined.
Defining Printer Settings
Defining Envelope / Label Styles



Define Printer Settings
This dialogue allows the return address and Print Style required to be specified.

Return Address
When Smart Address prints an entry, it prints that entry according to a Print Style. A part of the style 
is the choice to print a Return Address along with the entry. This dialogue allows the return address 
to be specified for any style requiring it. Once entered the address is available to all Address Books.

Print Style
This allows the print style required to be selected from a pre-defined set of envelope and label styles.
The style required should be selected by clicking on the style name. If you require to change any 
attribute of the style, then press the DEFINE button.

Setup
This button invokes the Windows Printer Set-up command, allowing the default printer to be changed
or it's options updated.



Define Envelope and Label Settings
This dialogue allows the attributes allocated to a Print Style to be updated. Changes made to any 
Style are saved.

Print Style
This field indicates the name of the Style being updated.

Measurement Units
This field indicates the unit of measurement that will be used for any offset values defined to the 
Style. This unit can be changed by use of the 
Windows Control Panel.

Return Address
This group of fields allows the offset values for the Return Address to be specified, along with the 
font to be used to print the Return Address. The 
offset values are used in positioning the return address in relation to the envelope or label.

Mail Address
This group of fields allows the offset values for the entry's mail address to be specified, along with 
the font to be used to print the mail address. The offset values are used in positioning the Mail 
Address in relation to the envelope or label.

Logo Positioning
This group of fields allows the offset values for the Logo to be specified. These values are used in 
positioning the Logo on the Envelope or Label.

Orientation ( Envelope Styles Only )
This allows the orientation of the envelope, either portrait or landscape, to be chosen.

Options
These options allow the use of a Logo and/or Return Address to be chosen. If a logo is to used, then 
the SET LOGO Button allows the BMP file to be used for the logo to be selected.

Layout ( Label Style Only )
See Also Label Layout
This button invokes the Label Layout dialogue which allows the label layout to be defined.



Define Label Layouts
This dialogue allows the physical layout of the labels to be defined. This allows any pre-defined 
labels to be updated or Styles created for user defined labels.

Print Style
This field indicates the name of the Label Style being updated.

Measurement Units
This field indicates the unit of measurement that will be used for any offset values defined to the 
Label Style. This unit can be changed by use of the 
Windows Control Panel.

Print Style
This field indicates the name of the Print Style being updated.

Label Definitions
These fields define the actual labels being used:
n Number of Label Across
n Number of Label Down
n Label Width
n Label Height
n Top Margin
n Left Margin
n Horizontal Gap
n Vertical Gap
n Number of Labels to Skip



The Status Bar
Smart Address uses a Status Bar at the bottom of the Smart Address Application Window. This bar is
used to indicate how many and what selection of entries are currently being displayed.

If the Address Book display has been filtered by use of the Index Command or the Find Command, 
this will be reflected on the Status Bar.

For example, if the INDEX has been set to show all entries beginning with the letter 'W' that are 
contained in the Category group "Personal", of which there are 47, then the Status Bar will display :-

47 Entries for the Category "Personal" Starting with "W"



Inserting an Entry to a Word Processor
Smart Address is able to insert Entries directly into a Word Processor document by use of the Insert 
to Word Processor Command
In order for Smart Address to insert an entry, that entry must first be selected and the Word 
Processor must be running with a document active. The Insert to Word Processor Command should 
then be used. Smart Address will then insert that Entry into the current document using the cursors 
position as an insert point and then switch to the Word Processor, leaving Smart Address running in 
the background.
By making use of the Macro facilities with your Word Processor, it is possible to add a command in 
your Word Processor that invokes Smart Address. This allows for you to then call Smart Address 
while editing your document, select the entry required and have Smart Address insert that entry into 
your document and then returning control back to the Word Processor.

As an example of this, Smart Address comes with a Word for Windows Macro that adds the facility to
invoke Smart Address to the Tools Menu. In order to run this macro, open the SMARTMAC.DOC file, 
located in the same directory as you installed Smart Address, using Word for Windows.



Importing a Text File
Smart Address allows text files containing Names and Addresses to be imported to an Address Book.
Smart Address will import each line of text as a separate entry with the fields being delimited by a 
certain character.

If the fields being imported are enclosed by double quotes ("), then the quotes will be removed by the
import process.

When IMPORT is selected, a dialogue box will be displayed for selection of the file to be imported 
and the character that delimits each field.

When the file and character have been specified another dialogue box is displayed, which allows the 
fields in the text file to be mapped to fields in the Address Book.

When the dialogue is displayed, Smart Address lists the import fields available under Fields for 
Importing. Each field should then be mapped to the appropriate Address Book field, by clicking a 
Mapped Import Fields Button. These buttons will then show which field(s) have been mapped to 
which Address Book fields.

To remove the mapping for an Import Field, click on the Mapped Import Field Button that is mapped 
to the appropriate field. This will then enable that field to be re-selected if required.

Once all the required fields have been mapped, the file can be imported to the currently selected 
Address Book.

See Also:
Importing Address Fields



Importing Address Fields
Some Applications export Address fields as one field with each field being separated by a End-of-
Line marker. For example a three line address field could be exported as :-
"210 Main Road<eol>Large Place<eol>Peoplesville"
In this situation, Smart Address will pick up the three Address lines as one field. In order for these 
fields to be mapped correctly, that is to the first three Address fields in Smart Address, then this 
'single field' should be mapped to the first Address field. Smart Address will then split each of the 
Address Lines up and populate the other Address fields automatically. For example, in the above 
case Smart Address would import the field as:-
Address Field 1 : 210 Main Road
Address Field 2: Large Place
Address Field 3: Peoplesville



Exporting Address Book Entries
Smart Address allows entries to be exported from an Address Book to a text file. Smart Address will 
export each entry as a separate line of text, with the fields being delimited by a certain character and 
each field enclosed in double quotes ("). 

When EXPORT is selected, a dialogue box will be displayed allowing the output file name and 
delimiting character to be specified.

When the file and character have been specified another dialogue box is displayed, which allows the 
order in which the Address Book fields are to exported to be chosen. When the dialogue is displayed,
Smart Address lists the available Address Book fields under Fields for Exporting.

Each field should then be mapped to the appropriate Address Book field, by clicking a Map Output to 
button which will then indicate the mapping chosen in the Mapping Details field.

Once all fields have been mapped the entries can be exported to the text file. Smart Address uses 
the Display Index to identify which entries are to exported. This allows partial exports to be made 
using the Index facilities of Smart Address.



Configuring a Modem for Auto Dial
If you wish to use the Auto-Dial facility of Smart Address, where Smart Address will dial a telephone 
number from an Address Book for you, then you will need a modem connected to your PC. Smart 
Address then needs to be told certain information about your modem to allow it to communicate with 
the modem.

The Auto-Dial Configuration command allows for that information to be specified:

Initialisation String
This field allows a string to be entered that will be used to initialise your modem and will be sent to 
the modem prior to dialling the number. A usual use for this is to adjust the speaker volume of the 
modem. For details of the values that can be used for this string, please consult your modem's 
manual.

Port
This should be set to the port that the modem is connected to.

Baud Rate
This should be set to the speed of your modem. For more details, please consult your modem's 
manual.

Dial Tone
This should be set to the type of telephone system you are using, which will be either PULSE or 
TONE.

Length of Extensions
This field allows the length to be used for the Auto Identify Extension facility when using Auto-Dial. 
The length used should be the number of digits that make up your internal extension numbers.



Menu Commands
File Menu
Edit Menu
Search Menu
Options Menu
Windows Menu



File Menu
n New Command
n Open Command
n Close Command
n Print Command
n Printer Setup Command
n Import Command
n Export Command
n Exit Command



Edit Menu
n Undo Command
n Copy Entry Command
n Paste Entry Command
n Add Entry Command
n Update Entry Command
n Apply Addition/Update Command
n Cancel Addition/Update Command
n Delete Entry Command
n Insert to Word Processor Command



Search Menu
n Find Command



Options Menu
n Fonts Command
n Set Field Labels Command
n Define Word Processor
n Auto-Dial Configuration Command
n Dial Number Command
n Index Command



Windows Menu
n Cascade Command
n Tile Command
n Arrange Icons Command
n Close All Command
n List of Books



The Toolbar

New Command

Open Command

Undo Command

Add Entry Command

Update Entry Command

Apply Addition/Update Command

Cancel Addition/Update Command

Delete Entry Command

Find Command

Reset Index Button

Index Command

Dial Number Command

Print Command

Insert to Word Processor Command



Hints and Tips
Customising Smart Address
Copying Selected Text to or from the Windows Clipboard
Updating an Entry
Quickly Invoke the Index Command
Adding new Word Processors
Creating a Microsoft Word MailMerge Data File



Customising Smart Address
Changing the Default Field Labels
Adding New Envelope and Label Styles



Changing the Default Field Labels
When Smart Address creates a new Address Book, it automatically assigns a default set of field 
labels to that book. The Set Field Labels Command on the OPTION Menu, allows these names to be
redefined in the current Address Book. If you require to change the default field labels used by Smart
Address when creating new Address Books, then you need to add the following ( ignore comments 
after ";" ) to the SMARTADR.INI file in your Windows directory.
[Default Labels]
1=xxxxxxxx  ;label required for the first field
2=xxxxxxxx  ;label required for the second field
; ... and so on for 3,4,5,6,7,8,9,10 ...
11=xxxxxxxx ;label required for the last field  
This will then replace the default field label used, with the entry Smart Address finds in the above 
section. For example, if you want to change the label used for the first field ( by default this is 
NAME ) to COMPANY, then add the line

1=Company

to the DEFAULT LABELS section.



Adding New Envelope and Label Styles
Smart Address comes with a set of pre-defined Envelope and Label Styles, but these styles will 
never provide all the styles a user might required. Therefore, Smart Address allows new styles to be 
defined by adding an entry for the Style in the STYLES section of the SMARTADR.INI file in your 
Windows directory. 

Once a Style has been added, the Printer Setup Command should be used to define the various 
attributes of the new style.

The format of the line to be added to the SMARTADR.INI file is :-
[Styles]
xxxxxxxx=nn

; xxxxxxxx = The Name of the New Style
; nn = 11 for an Envelope, 12 for a Label  

Likewise, if you wish to remove any of the pre-defined styles, then simply delete the relevant line 
from the STYLES section.



Copying Selected Text to or from the Windows 
Clipboard
Smart Address provides the facility to copy complete entries to or from the Windows Clipboard, by 
the use of the Copy Entry Command and the Paste Entry Command on the EDIT menu. If you need 
to copy single fields or parts of a field to the Clipboard, then you should:-

To Copy to the Clipboard
Highlight the text or field to be copied and then press the CTRL key and the C key at the same time. 
This will then copy whatever was highlighted into the Clipboard.

To Copy from the Clipboard
Place the cursor at the position you require the text to be inserted and then press the CTRL key and 
the V key at the same time. This will then insert the text from the Clipboard at the indicated position.



Updating an Entry
In addition to the Update Entry Command, Smart Address also allows an entry to be updated by 
using the TAB Key to tab across to the fields of the Entry or, for quicker access, simply by clicking the
mouse on the field to be updated.



Quickly Invoke the Index Command
In addition to the use of the Index Command, Smart Address will display the INDEX dialogue, 
whenever the right mouse button is clicked on an Address Book Window.



Adding new Word Processors
Smart Address uses settings in the SMARTADR.INI file to identify word processors. It locates the 
requested Word Processor by looking at the Window caption of all active applications.
If you need to add support for other Word-Processors do the following:-

n Edit SMARTADR.INI using Notepad. SMARTADR.INI is in your Windows directory.
n Locate the [Word Processors] section.
n Add a new line as follows:

Descriptive Name=Caption on Title Bar

For example, to add support for a Word Processor called 'SmartWrite', which has a caption bar 
starting "SmartWrite For Windows", add the following line

SmartWrite=SmartWrite For Windows

Be sure that you are accurate with the capitalization, otherwise you may get a 'Word Processor 
not running' error message, when it really is!



Creating a Microsoft Word MailMerge Data File
The export files Smart Address produces can be used as Data Files in Microsoft Word Mail-Merge 
operations. Smart Address exports only those names actually visible in the active address book, 
which allows considerable flexibility in creating the list of names to be 'merged'.
There is one thing to bear in mind though. Smart Address exports as the first record the list of field 
names, which is ideal because Microsoft Word will pick this up automatically to help you construct 
the main document. But, Microsoft Word will not allow field names that are blank or that contain 
blanks.
There are two ways to solve this problem.
n Use the Set Field Labels command on the Options menu to change the field labels so they are 

not blank, and do not contain blanks, or perhaps preferably:-
n Export the file from Smart Address as-is, blanks included, and when you attach the data file in 

Microsoft Word it will pop up a message saying 'Error in Data File' and giving you the option to fix
it. Select the 'Fix Now' option, and change the FIRST LINE ONLY so none of the fields are blank 
or contain blanks.

Other Word Processors
A similar approach will probably also work with other Word-Processors, but they have not been 
tested.



How to Get Support and Register
We of course provide a full support service to registered users, either by phone, fax, mail, E-Mail or 
Bulletin Board. Look below for details of an agent in your territory. We are also quite happy to provide
sufficient support to unregistered users to at least get you going. After all, we can hardly expect you 
to buy our product if you can't make it work properly!
United Kingdom
North America
France
Rest of the World

Registering Smart Address



Support in The United Kingdom
Oakley Data Services,
3, Oakley Close,
Sandbach,
Cheshire
CW11 9RQ 
England.

Phone (+44) (0)270 759739 
Fax (+44) (0)270 765272

CompuServe Id: 100024,1763

or by BBS via The Shareware Support BBS, on 0442-891109 or 0442-890807,    which we visit at 
least once a week. Note however that we don't take orders via the BBS.



Support in North America
Shareable Software International Inc.
P.O. Box 240357,
Apple Valley,
MN 55124,
U.S.A.

Phone: (612) 322 5868
Fax: (612) 322 5871 

CompuServe Id: 76226,2652

or by BBS via The Runway BBS, on 215-623-6203. Users of the BBS must join Conference 77



Support in France
WindowShare SARL
B.P. 2078, 
57051-METZ cedex 2,
France.

Phone (+33) 87 30 85 57
Fax (+33) 87 32 37 75

CompuServe Id: 100031,3257



Glossary
A
Add Entry Command
Address Book
Apply Addition/Update Command
Arrange Icons Command
Auto Identify Extension
Auto-Dial Configuration Command

C
Cancel Addition/Update Command
Cascade Command
Close All Command
Close Command
Copy Entry Command

D
Define Word Processor
Delete Entry Command
Dial Number Command

E
Exit Command
Export Command

F
field labels
Fields for Exporting
Fields for Importing
Find Command
Fonts Command

H
Horizontal Gap

I
Import Command
Index Command
Insert to Word Processor Command

L
Label Height
Label Width
Left Margin
List of Books

M
Map Output to button
Map to Button



Mapped Import Fields
Mapping Details

N
New Command
Number of Label Across
Number of Label Down
Number of Labels to Skip

O
Open Command

P
Paste Entry Command
Print Command
Print Style
Printer Setup Command

R
Registering Smart Address
Reset Index Button
Rest of the World
Return Address

S
Scroll Bar
Set Field Labels Command
Shareware
SMARTADR.INI
Status Bar

T
Tile Command
Top Margin

U
Undo Command
Update Entry Command

V
Vertical Gap



Define Word Processor
Smart Address enables Entries to be automatically inserted into your Word Processor. In order for 
this to work, Smart Address needs to know which Word Processor you are running. This dialgoue 
allows you to specify that Word Processor.

Current Word Processor:
This field lists the currently defined Word Processor. If no Word Processor has yet been defined to 
Smart Address, then this will show as < Not Defined >.

Available Word Processors:
This field presents a list of the Word Processors currently supported by Smart Address and the Word 
Processor to be used should be selected from the list.

If your word processor is not listed, refer to the hints and tips section on how to add it.
Once you have selected the Word Processor, select OK to continue.



Dial a Number
When the Dial Number Command is selected a dialogue box will be displayed for you to specify 
which number you want to dial and also if you wish to add a prefix to the number.

The prefix is used in environments where a number has to be dialled to obtain an outside telephone 
line. Entering a prefix and selecting the USE PREFIX option, will ensure that any number you dial, 
with the exception of the Auto Identify Extension facility, will be preceded with the required prefix.

An alternative to using the Dial Number Command is to use the DIAL button to the right of each 
telephone number field. This will auto-dial the number associated with it, using the currently defined 
prefix if the option has been enabled.



Print Command
The PRINT command will display a PRINT dialogue box that allows you to specify the print you 
require. Once you have specified the print options required, or accepted the defaults, you should 
press the OK button to produce the print.

The options on this dialogue are :-

Printer
This lists the printer that is currently selected in Windows to produce any print requests.

Range
There are two options available to indicate the range of the print. If the first option, "Selected 
Address", is specified then the currently selected entry in the Address Book will be printed. This entry
is detailed under "Selected Address". 

The other option is for the complete Index list to be printed. This allows for the complete Address 
Book, or a sub-set of it, to be printed in one go. To create a sub-set of the Address Book, use the 
Index Command or the Find Command.

Selected Address
This details the entry that will be printed if the Selected Address option is chosen.

Setup
This invokes the Printer Setup Command, allowing the Print Styles and/or the defined Windows 
Printer to be changed.



Enregistrement Francophone
Vous pouvez imprimer ce bon de commande en cliquant sur "Fichier" "Imprimer"

Expédier à :
 WindowShare,
 B.P. 2078,
 57051-METZ cedex 2,
 France

Envoyez-moi __ exemplaires enregistré(s) de Smart Address

Prix :
250FF

Prix Total : .......................
Ci-joint un chèque / mon numéro de MasterCard ou VISA (rayez les mentions inutiles)

16 chiffres de la carte de crédit:-
Nom du Porteur:

Date d'Expiration:

Nom:

Adresse:

Code Postal :                                                Tél. :

Vous pouvez aussi nous contacter par:
Vox: (+33) 87 30 85 57
Fax: (+33) 87 32 37 75

Compuserve : 100031,3257,

InterNet : 100031.3257@compuserve.com

Minitel : 3615 WinShare,
 Boutique LICENSEWARE (carte de crédit seule)



UK Registration Form
You can print this order form by using the "Print Topic" option from the "File" menu.

To:-
Oakley Data Services,
3 Oakley Close,
Sandbach,
Cheshire CW11 9RQ,
England.

Please send me __ registered copy(s) of Smart Address, together with Shareware Versions of some 
of your other software.

Prices:-
UK and EEC
17.00 Pounds Sterling including P&P, plus VAT (17.5%) = 19.97 Pounds Sterling per copy

Rest of the World
17.00 Pounds Sterling plus 2.00 Pounds Sterling P&P = 19.00 Pounds Sterling per copy.
(Unless otherwise requested we ship a 3.5" HD disk)

Total Price : .......................
I enclose a cheque / wish to pay by MasterCard / Visa (delete as applicable)

Credit Card Details:-
Name as on card:-

Card Number:- 

Expiry Date:-

Please send the registered version to:-

Name:

Address:

Post Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone: +44 (0)270 759739
FAX: +44 (0)270 765272

Compuserve: 100024,1763

Internet: 100024.1763@compuserve.com

It would also help us if you could tell us where you got Smart Address from:-



And any suggestions you have for enhancements.



North America Registration Form
You can print this order form by using the "Print Topic" option from the "File" menu.

To:-
Shareable Software International, 
P.O. Box 240357,
Apple Valley,
MN 55124, 
U.S.A.

Please ship me __ full copy(s) of Smart Address

Prices:-
USA and Canada
$24.95 US Dollars, plus $4.00 Shipping and Handling

Add an additional $5.00 for overseas shipping

Total Price : .......................
I enclose a check / wish to pay by MasterCard / Visa (delete as applicable)

Credit Card Details:-
Name as on card:-

Card Number:- 

Expiry Date:-

Please send the registered version to:-

Name:

Address:

ZIP Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone: (612) 322 5868
FAX: (612) 322 5871

Compuserve: 76226,2652, 

Internet: 76226,2652@compuserve.com,

or call the Orderline on :- 800-622-2793

It would also help us if you could tell us where you got Smart Address from:-



And any suggestions you have for enhancements.



Add Entry Command
This command allows a new entry to be made to the Address Book. Selecting this command clears the 
entry fields and places the input focus in the first field. Information can then be entered and the input 
focus changed to the next field by use of the TAB key or the mouse. Once the fields are completed, the 
APPLY or CANCEL commands should be used. Until the APPLY or CANCEL commands have been 
used, all functions not relating to the adding of a new entry will not be available.



Address Book
Smart Address holds your telephone and address entries in a Address Book, with each Address Book 
being held as a separate file on your disk using the prefix '.ADR'.Smart Address automatically saves 
each alteration made, to ensure that if your computer should fail for any reason, any changes made will 
not be lost. Because Smart Address allows for more than one Address Book to be open at any time, you 
can group your entries into physical books. This could allow for example, the grouping of all your 
personal numbers into one book and your business numbers in another.



Apply Addition/Update Command
This command will save the data for the entry into the currently selected (active) Address Book. 



Arrange Icons Command
Arranges into rows all Address Book Icons. 



Auto Identify Extension
The Auto Identify Extensions option is used to automatically recognise internal telephone extension 
numbers. This allows Smart Address not to use any defined prefix for telephone numbers. For example: 
if you need to prefix '9' to connect to an outside telephone number, you would set 'Use Prefix' up with the
number '9', this would then always prefix the number '9' to any number selected for dialling. In the case 
of an internal extension number, you can set the 'Auto Identify Extension' value to the length of your 
extension numbers. Smart Address will then check the length of any telephone number being dialled and
if it equals this length, will not prefix '9' to the number.



Auto-Dial Configuration Command
This command enables Smart Address Auto-Dial facility to be configured for the type of Modem 
connected to the PC.



Cancel Addition/Update Command
This command will cancel any changes made to an entry, or cancel the addition of a new entry following 
the use of the ADD or UPDATE commands.



Cascade Command
Arranges open Address Books so that the title bar of each window is visible. 



Close All Command
Closes all opened Address Books.



Close Command
This command will close the currently selected (active) Address Book. If the Address Book is currently 
being updated, i.e. an addition or update is in progress, then a query will be issued to confirm the closing
of that Book.



Copy Entry Command
This command will copy all fields of the currently selected entry and place it in the Windows Clipboard. 
This allows the entry to be copied into another Address Book, via the Paste command or into another 
application.



Define Word Processor
This command allows the Word Processor to be selected from a list of currently supported Word 
Processors.



Delete Entry Command
This command will delete the entry that is currently selected from the Address Book. Before deletion 
takes place, a message will be issued requesting confirmation that the entry is to be deleted.



Dial Number Command
This command allows any number in an entry to be dialled via a connected modem. If the modem 
settings have not been defined, via the AUTO-DIAL CONFIGURATION command, then an error 
message will be displayed.



Exit Command
Exits Smart Address and closes any open Address Books. If any Address Book is being updated, i.e. an 
addition or update is in progress, then a query will be issued to confirm the closing of that Book. Smart 
Address will save the current state of itself and all opened Address Books. When Smart Address is next 
started, it will open and restore the position and settings of all Address Books. This includes the index 
settings in effect.



Export Command
This command enables the displayed entries from an Address Book to be exported to a Text File. This 
option allows the delimiter character for the fields to be chosen and the Address Book fields mapped to a
specified output order.



field labels
Each Address Book entry consists of 10 fields and a freeform text field. Each of these 11 fields can have 
a label assigned to it which can be changed by using the Set Field Labels Command.



Fields for Exporting
This list box displays an entry for each field in the Address Book along with the label defined for that 
field. A field should be selected, by clicking the mouse on the entry for that field in the list box, and then 
the appropriate mapping defined using the MAP OUTPUT TO buttons. 



Fields for Importing
This list box displays an entry for each field identified in the import file along with an example of the 
fields contents taken from the file. A field should be selected, by clicking the mouse on the entry for that 
field in the list box, and then the appropriate mapping defined using the MAP TO buttons. 



Find Command
The FIND command displays a dialogue box that enables a search to be performed against the current 
Address Book. The Address Book's Display Index is changed to reflect the result of any search, but may 
be re-established by selecting the INDEX command and clicking the OK Button.



Fonts Command
This command allows a different font, style and font size to be chosen. The new font will then be used 
for any Address Books opened.



Horizontal Gap
This field is used to specify the width of the gap, in the listed measurement unit, between each Label 
across the page.



Import Command
This command enables a Text File to be imported to the current (active) Address Book. The option 
allows for the delimiter character between fields to be defined and the fields to be mapped to the 
relevant Address Book fields.



Index Command
This command enables the Display Index to be set. The Display Index is the control over which Address 
Book entries are displayed in the scrollable list of entries. By default all entries are displayed, but this 
can be altered by using the INDEX command. Entries can then be displayed that begin with a certain 
character and/or are in a certain category. 



Insert to Word Processor Command
This command extracts the currently selected Entry and Inserts the    first five fields of that entry into an 
active Word Processor Document. The Word Processor to be used, must have already been defined via 
the Options Menu and be running.



Label Height
This field is used to specify the physical height, in the listed measurement unit, of each Label.



Label Width
This field is used to specify the physical width, in the listed measurement unit,of each Label.



Left Margin
This field is used to specify the width of the margin, in the listed measurement unit, between the left 
edge of the page and the left edge of the first Label



List of Books
The names of all opened Address Books are listed at the bottom of the Window menu. To select a 
Book, choose its name from this list. 



Map Output to button
There is a 'Map Output to' button for each available export field. Selecting one of these buttons will map 
the currently selected entry in the 'Fields for Exporting' list box to that export field. A fields mapping may 
be removed by selecting the button for the field again.



Map to Button
There is a 'Map to' button for each Address Book field which are labelled with the Labels currently in 
effect for the Address Book. Selecting one of these buttons will map the currently selected entry in the 
'Fields for Importing' list box to that Address Book field.    A fields mapping may be removed by selecting 
the button for the field again.



Mapped Import Fields
Up to two Import Fields can be mapped to a single Address Book field, therefore allowing two fields from
the Import file to be merged together.



Mapping Details
The 'Mapping Details' fields are used to indicate what    fields have been mapped to what Address Book 
fields.



New Command
Allows you to create a New Address Book and name the disk file that is to hold it. Once created, Smart 
Address will load the new book and make it the currently selected (active) book.



Number of Label Across
This field is used to specify the number of Label across the page.



Number of Label Down
This field is used to specify the number of Labels down the page.



Number of Labels to Skip
This field is used to specify the numbers of Labels that Smart Address skips before starting printing.This 
allows for a single label to be printed on a page and the same page to be used another time to print 
another Label.



Open Command
Enables an existing Address Book to be loaded. Smart Address allows for multiple Address Books to be 
open at the same time. Each Address Book opened will be contained in it's own Window, and will be 
independent of any other opened book.



Paste Entry Command
This command will copy the contents of the Window Clipboard, providing the Clipboard contains text, 
into the entry that is currently being updated. To make the Paste Entry Command available for an entry, 
use the Add or Update commands. Smart Address maps the fields of the text in the Windows Clipboard 
to the Address book fields in order. That means the first line of the Clipboard text is copied to the first 
Address Book field and so on for the first ten lines. The eleventh and subsequent lines, are all copied 
into the freeform text field.



Print Command
This command prints Envelopes or Labels for either the currently selected Entry or all the entries 
displayed within the current (active) Address Book. 



Print Style
A Print Style defines the layout of the envelope or label being printed.



Printer Setup Command
This command allows for the Printer to be chosen and configured. Also enables the Print Style to be 
selected and/or configured.



Registering Smart Address
To register Smart Address, please use the ORDER FORM option on Smart Address's Help Menu.



Reset Index Button
This Toolbar Button resets the Display Index to display all Address Book entries.



Rest of the World
For support outside of North America and France, please use the United Kingdom Agent.



Return Address
An Address that is added to Envelopes to indicate the Senders Address.



Scroll Bar
A bar that appears at the right and/or bottom edge of a Window or List Box when its contents are not 
completely visible. Each Scroll Bar contains two scroll arrows and a scroll box that enable you to scroll 
through the contents of the Window or List Box.



Set Field Labels Command
The SET FIELD LABELS command, displays a dialogue box listing the labels currently in effect. To 
change any label, simply replace the label with a new value. 



Shareware
Shareware is copyrighted software which is distributed by authors through bulletin boards, on-line 
services, disk vendors, and by copies being passed among friends. It is commercial software that you 
are allowed to try before you pay for it. This makes shareware the ultimate in money back guarantees.     
Shareware is a distribution method, not a type of software.There is good and bad shareware, just as 
there is good and bad retail software. The primary difference between shareware and retail software is 
that with shareware you know if it's good or bad before you pay for it.      You benefit because you get to 
use the software to determine whether it meets your needs, before you pay for it.    Authors benefit 
because they are able to get their products into your hands without the expenses it takes to launch a 
traditional retail software product.        The shareware system and the continued availability of quality 
shareware products depend on your willingness to register and pay for the shareware



SMARTADR.INI
The file used by Smart Address to hold information relating to the settings and preferences in effect.



Status Bar
The Status Bar is the Horizontal Area at the bottom of the Smart Address Window. This is used to 
indicate the range of entries displayed in the current Address Book.



Tile Command
Arranges open Address Books in a tiled effect, so that all of them are visible. 



Top Margin
This field is used to specify the height of the margin, in the listed measurement unit, between the top of 
the page and the top of the first Label.



Undo Command
This command undoes the last alteration made to the selected (active) Address Book



Update Entry Command
This command moves the input focus to the first field of the entry and enables the data in the fields to be
amended. The input focus can be moved through the fields by use of the TAB key or the mouse. Once 
the amendments have been made, the APPLY or CANCEL commands should be used. Until the APPLY 
or CANCEL commands have been used, all functions not relating to the updating of an entry will not be 
available.



Vertical Gap
This field is used to specify the height of the gap, in the listed measurement unit, between each Label 
down the page.






